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1 Introduction
Color Management is often thought of as difficult to understand and
difficult to use. In fact, with a little time and practice, it is possible
both to understand and use color management effectively. 

This Color Management User Guide is written with digital 
photographers in mind. The aim is to provide sufficient information,
for the digital photographer, so that the finished result, whether it is 
a JPEG file for the internet, an image made on an ink jet printer, or 
a photograph reproduced in a magazine, is as faithful to the original
subject as is possible.

Standardization of color values and calibrating devices
The key to successful color management is standardization. 
The basic concept is this: 

If the color values of the original subject are known, and measured
accurately, then it must be possible to observe and measure any
changes in color value as the subject is reproduced, and at any stage
in the reproduction process.

In fact changes in color value always occur. Some changes are a
result of the color space gamut (“gamut” is another word for “range”)
– for example a printer may not be able to produce the same range
of colors that can be seen on a monitor. 
Other changes in color value occur when the same color is viewed in
different environments.

The key to a successful calibration is to put every device into a known
state, which is to say the device default settings. 
The color output of each device can then be measured and 
compared.
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When measuring the color output of any device the original subject 
is often a color chart with known values. Each stage in the process,
from taking the picture (Camera), viewing and editing the picture
(Monitor), and finally publishing the picture (Printer or Monitor), 
can then be evaluated and compared to the original subject.

Workflow Devices
There are typically three devices in any workflow: The camera, the
monitor and the printer. These devices must be calibrated before use.
Although a detailed description is provided later in this guide, the key
steps are as follows:

- The camera – Every Phase One camera back is calibrated 
before leaving the factory. Calibration information 
is automatically transferred to the computer when the 
camera back is connected to a computer. 
All the photographer needs to do is to specify the light 
source, the scene characteristics and the gray balance in 
the Phase One software.

- The monitor – It is important to get a good match between 
the monitor color temperature and the environment color 
temperature, as well as ensuring that the monitor shows 
accurate color and the best possible range of brightness 
and contrast.

- The printer – Often a printer comes complete with a profile 
(a description of how it reproduces color). 
The profile is used in the workflow to ensure the best possible 
reproduction quality. The photographer may have a printer 
profile, supplied by a customer, or printing house.

In addition there is a theoretical fourth device – the Profile 
Connecting Space (PCS). This can be considered the “perfect” 
device where every humanly visible color can be reproduced. 
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As the name - Profile Connecting Space  - suggests this device 
actually forms a link between all other profiles. It is within the 
PCS that the computer calculates the correct balance and 
correction when moving from one physical device to another.

The purpose of profiles

Human Vision and color values
The visible spectrum is a very narrow section of a vast range of radio
waves. At one end of the entire range are; long wave radio waves,
VHF radio, television, Radar, microwaves and infrared. Then comes
the visible spectrum, followed by ultra violet light, X-rays, Gamma
rays and cosmic rays.

To a certain extent human vision can be described and measured.
Thus we can say that most people with healthy vision can see the
same visible spectrum.

The visible spectrum can be described both by name and by number.
Numerically the visible spectrum starts at 380 nm (nanometers) and
ends at 780 nm. So when we humans register a wavelength of about
450 nm we say we see “blue”. When we register a wavelength of
about 700 nm we say that we see “red”.

We also say that the sky is “blue”, that the setting sun is “red” and
that grass is “green”, and we can all agree at a superficial level.
However, when it comes to evaluating and comparing images we 
can be remarkably accurate as well as easily fooled.

Therefore we need an objective method to measure and define 
color values, upon which we can all agree. Color management 
is the method and profiles are the key.
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Using profiles in color management 
A profile is an accurate description of how a device reproduces 
color. A device can be a camera, a screen, or a printing process. 
The profile is analyzed by a computer, which then automatically 
compensates for any variations in the way a series of devices 
reproduce color. In this way the color of the original subject can 
be accurately reproduced, and measurably consistent, from shooting
to the finished result. 

A typical setup in a photographer’s studio may comprise of a 
Phase One camera, a high-end computer and monitor as well as 
photographic quality printer. Every shot that is taken goes from the
Phase One camera, through the computer, and is shown on the 
monitor. The computer reads the profiles of each device, compensates
for the way each device reproduces color, and displays the finished
result on the screen. 
It is then the job of the photographer to decide if any further 
adjustment is needed. Computers equipped with device profiles 
show only how a device reproduces color. They do not tell the 
photographer what to do if the device, or process, cannot reproduce
the color accurately. Often it will be the printing process that sets the
greatest limitation to color reproduction, although each step in the
process adds its own layer of limitations.

Color spaces – color in 3D
People describe colors in a variety of ways, and most descriptions 
are entirely subjective. To avoid human error, several systems have
been developed to give color a value and to define relationships
between colors. It is beyond the scope of this guide to describe them
all in detail - fortunately they have many things in common. Each 
system can describe individual colors, as well as a range of colors. 
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Individual color 
The relationship between individual colors, and ranges of colors, 
are often defined in three dimensions. These dimensions have names: 

Hue - The name of the color.

Saturation - The strength of the color. Neutral gray has no 
saturation. As more color is added to the neutral gray the level 
of saturation increases.

Brightness - The measurement of light transmitted or reflected from
an image The hue of an image may be blue, but the brightness can
vary considerably.

A combination of Hue, Saturation and Brightness (HSB) defines an
individual color.

To visualize this three-dimensional space, imagine a globe with a
North Pole, an equator, and a South Pole. Let us call it the HSB globe.

At the North Pole everything 
is pure white, no other colors
are visible, there is maximum 
brightness. Moving 
southwards, towards the 
equator, colors start 
becoming visible. 

If the globe is sliced in half, 
at the equator, each color can
be seen as part of a circular 
spectrum. At the core of the
globe neutral gray is the 
meeting point of all colors. 
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As the colors move away from the core, they become stronger, their
saturation increases. At the surface of the globe saturation is 100%,
and each color is easily identified. Following the equator around the
globe red blends through magenta and violet to blue. Blue merges
into green and green merges into yellow. Finally yellow merges back
into red.

Moving onwards again towards the South Pole, colors gradually
become darker. Finally, at the South Pole, everything is black.

Color gamuts – Color in 2D
A way of describing the range of color that a device is able to 
register is to say that it has a “gamut”. Gamut is another word for
range and it is frequently used when describing the color limitations
of devices.
The gamut of visible colors, represented within the HSB globe, can
also be shown as a flat, two-dimensional chart. The shape of the
chart shows the range of colors that the human eye can register. 
A black border indicates the approximate limit of each device.

A Phase One camera has a very large dynamic range – 
which also gives a very large gamut. 
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Visible spectrum Phase One camera

Film has a slightly smaller gamut than a Phase One camera, and 
the gamut of a high quality film scanner is slightly smaller than film. 

The color gamut of a high quality computer screen is slightly different
to the gamut of a film scanner. 

Finally a printer, or printing process, often has a very different, 
and much smaller, gamut.

Not only must we take into account the limited range of colors that
can be reproduced as the image moves from the camera to the final
print, we must also be aware that the gamuts do not always fit inside
each other. Sometimes gamuts can overlap, shift or expand in any
direction. Profiles are used to compensate for these reductions and
shifts.
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2 Color Management for Mac

Setting up the hardware

The camera
Every Phase One camera back is calibrated before it leaves the 
factory. When the camera is connected to the computer, calibration
data is transferred automatically. The photographer need only specify
the light source, the scene characteristics and the gray balance, using
the Phase One software.

The monitor
Next to the camera this is the most vital piece of equipment for the
photographer. Digital photography is difficult without an accurate 
picture of what the camera registers, and what the printer can 
reproduce.

A Mac can have two types of monitor, those made by Apple, 
and those made by another manufacturer. No matter what type 
is preferred, only high quality monitors should be used.

Newer Apple monitors, also called Studio Monitors, use ColorSync 
to ensure correct calibration. ColorSync is a color management 
technology developed by Apple. Other Apple and non-Apple 
monitors require different approaches to calibration. 

Although there are many methods used to calibrate monitors, 
Phase One recommends the following simple methods for good
results. No special equipment is needed.

2.1
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Calibration of Apple Studio Monitors:

- Turn the monitor on and let it reach normal working 
temperature – this may take 30 min.

- Open the Appearance dialog box in the Control Panels.

- Select Desktop –Patterns – Gray Space, and finally, Set 
Desktop. Close the dialog box. The screen background 
is now a neutral gray.

- Open the Monitor dialog box in the Control Panels.

- Set the contrast to 100% and set the brightness to 50%. 

- In the Monitor dialog box switch to the Color section.

- Select the “Studio Display “ ColorSync profile.

- Select: Preferences – Calibration Accuracy – Pro (Prepress). 
Then click OK.

- Set the White Point to “D50”, the Gamma Curve to 
“1.8 Standard” and Ambient Light compensation to 
“None”. Please note that to compensate for adverse 
viewing conditions the monitor should be fitted with a 
hood. This prevents light falling on the surface of the 
monitor. Ideally the viewing environment should also be 
neutral gray, and the ambient lighting set at 5000 
Kelvin.

Click Recalibrate. The monitor will then run a series of self-tests. 
This lasts a few minutes. When the tests are finished the screen 
returns to normal and the Monitor dialog box can be closed.

2.2
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Calibration of other Apple and non-Apple Monitors:

- Turn the monitor on and let it reach normal working 
temperature – this may take 30 min.

- Open the Appearance dialog box in the Control Panels.

- Select:  Desktop – Patterns – Gray Space, and finally, 
Set Desktop. Close the dialog box. The screen back
ground is now a neutral gray.

- Set the contrast to 100%. Most monitors have control 
buttons at the front, or a dialog box in the Control Panels.

- Adjust the brightness so that the dark 
border of the screen image is almost 
black. With some monitors it is 
possible to move the screen image to 
expose a larger border. This may help 
when evaluating how dark the border 
should be.

- With most quality monitors it is also possible to set the 
Monitor White Point. Select 5000 Kelvin (D50) if possible. 

- NB. Phase One recommends the use of high quality monitors.
However sometimes it may be necessary to compromise. 
Often 5000 Kelvin (D50) appears too yellow and dark on 
poor quality monitors. If this is the case then select 6500 
Kelvin. This setting will provide an acceptable compromise 
and reasonable viewing conditions.

- The final step, setting monitor gamma, is done after 
configuring Photoshop. Please configure Photoshop 
before continuing. See page number 2.5.

2.3
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- Open the Adobe Gamma control panel, which is 
included with Photoshop. 

- If the control panel 
opens in “Assistant” 
mode, change to 
“Control Panel” mode, 
before continuing. 
Select the option 
“View Single Gamma 
Only”.

- Open Photoshop and navigate to the LightPhase or 
Phase One Image Capture folder.

- Select and open the PhaseOne-CMS Checker Lowres.tif.

- At the bottom of the PhaseOne-CMS Checker are a 
color chart and a grayscale. 

- Adjust the Gamma control so that all the steps in the 
gray scale are clearly visible. To the right of the grayscale is 
an image of a model wearing a black hat. Ensure that there is
detail in the hat. Finally, check the lower right corner of the 
color chart. The color patch should be a deep “burgundy” 
red. 

- Often only very slight 
changes in gamma are 
needed to give an optimal 
result. When satisfied, 
close the control panel 
and save the profile.
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Setting up the software
For Photoshop 5.0 users

RGB
- Start Photoshop
- In the File menu, select Color Settings – RGB Setup.
- Select Adobe RGB (1998). Adobe RGB is a standard, 

and frequently used, color space.
- Select “Display Using Monitor Compensation”. 

All other settings are automatically taken from the 
monitor calibration. Click OK.

- The screen can now show accurate RGB values.

CMYK
- In the File menu, select Color Settings – CYMK setup.
- Select ICC as the option under CMYK Profiles.
- Select a profile that fits the type of color printer or printing 

process used. Printer profiles must be added to the ColorSync 
Profiles folder before they can be selected. Please note that if 
the screen is to showaccurate CMYK values then the correct 
ICC options must be set at all times. 

Sometimes it is not possible to predict which printing process
the customer will use. Therefore a “safe” option can be to
choose “Offset print -Euro or US catalog” combined with
“Heidelberg CMM”

The screen can now preview accurate CMYK values. 
This is particularly useful when previewing an image that will be
reproduced in a magazine or catalog, - especially if the colors 
are difficult to print. 
This technique is called “Soft-Proofing”

Color Management for Mac

2.5

Profile
- In the File menu, select Color Settings – Profile setup

- Check all the boxes in the Embed Profiles section. 
This allows other users of Photoshop to open the same 
image and view colors correctly. 
ICC profile aware software is the future of color management.
When an image has a profile embedded, the software can
accurately display and convert the color because the profile
instructs the color management system about the color profiles
of the devices that created or edited the image.

- Select the following for the Assumed Profiles: 
RGB - Adobe RGB (1998)
CMYK - select a suitable profile (if known) 
Grayscale - Gamma 1.8.
Assumed profiles instruct Photoshop what to do 
when an image does not have an embedded profile.

- Select the following for Profile Mismatch handling: 
RGB – Convert to RGB Color: 
CMYK – Ignore: 
Grayscale – ask when opening.

These settings instructs Photoshop what to do when the
assumed profile and embedded profile do not match. 
A mismatch occurs when an image has no embedded profile.

Three basic options are available:
- The mismatch can be ignored, in which case 

the image will be displayed without correction. 
- An image conversion can take place automatically, 

and a progress bar is displayed on screen.
- Finally a dialog box appears and the 

photographer is asked to make a choice. 
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The purpose of the Profile settings in Photoshop is to ensure 
that files are reproduced accurately on screen when opened. 
Often the standard – default – settings are suitable. 

Photoshop recognizes files with embedded profiles and can be set to
automatically convert, or ignore, or to ask before opening these files.

For Photoshop 6.0 users

- Start Photoshop. Insert the LightPhase application CD.
- In the Edit menu select Color Settings.
- Click “Load”
- Navigate to the LightPhase or Phase One Image 

Capture folder and open the Goodies folder.
- Open the Photoshop 6.0 settings folder and select the 

Photoshop 6.0 defaults. Click “Load”
- Photoshop 6.0 is now configured for use.

It is significantly easier to configure Photoshop 6.0.

Using the PhaseOne color checker with Apple Studio
Monitors

- Open Photoshop and navigate to the LightPhase or 
Phase One Image Capture application folder.

- Select and open the PhaseOne-CMS Checker Lowres.tif.

- Open the Monitor control panel.

Color Management for Mac
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- At the bottom of the PhaseOne-CMS Checker are a color 
chart and a grayscale. 

- Adjust the Brightness control so that all the steps in the 
gray scale are clearly visible. To the left of the grayscale is 
an image of a model wearing a black hat. Ensure that
there is detail in the hat. Finally, check the lower right 
corner of the color chart. The color patch should be a deep 
“burgundy” red.

Color Management for Mac
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3 Color management for Windows

Setting up the hardware

The camera
Every Phase One camera back is calibrated before it leaves the 
factory. When the Phase One back is connected to the computer, 
calibration data is transferred automatically. The photographer 
need only specify light source, scene characteristics and gray 
balance, using the Phase One software.

The monitor
Next to the camera this is the most vital piece of equipment for the
photographer. Digital photography is difficult without an accurate 
picture of what the camera registers, and what the printer 
reproduces. Only high quality monitors should be used.

Although there are many methods used to calibrate monitors, 
Phase One recommends the following simple methods for good
results. No special equipment is needed.

- Turn the monitor on and let it reach normal working 
temperature – this may take 30 min.

- Open the Screen properties dialog box

- Select the Gray Desktop background. Click “Apply” 
The screen background is now a neutral gray.

- Set the contrast to 100%. Most monitors have control 
buttons at the front of the screen.

Color Management for Windows
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- Adjust the brightness so that the dark border of the screen 
image is almost black. With most monitors it is possible to 
move the screen image to expose a larger border. This may 
help when evaluating how dark the border should be.

- With most quality monitors it is also possible to set the 
Monitor White Point. Select 5000 Kelvin (D50) if possible. 

- NB. Phase One recommends that only high quality monitors 
be used. However sometimes it may be necessary to 
compromise. Often 5000 Kelvin (D50) appears too yellow 
and dark on low quality monitors. 
If this is the case then select 6500 Kelvin. 
This setting will provide an acceptable compromise and 
reasonable viewing conditions.

- The final step, setting monitor gamma, is done after 
configuring Photoshop. Please configure Photoshop before 
continuing. See page 3.4

- Open the Adobe Gamma control panel, which is included 
with Photoshop, and found in the Help menu under Color 
Management.

- If using Windows 2000 please read the notes 
“Using the PhaseOne color checker with monitors - 
recommended for Windows 2000” on page 3.7

Color Management for Windows
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- If the control panel opens in “Assistant” mode, change 
to “Control Panel” mode, before continuing. Select the 
option “View Single Gamma Only”

- Open Photoshop and navigate to the LightPhase or 
Phase One Image Capture folder and open the 
PhaseOne-CMS Checker Lowres.tif.

- At the bottom of the PhaseOne-CMS Checker are a color 
chart and a grayscale. 

- Adjust the Gamma control so that all the steps in the gray 
scale are clearly visible. To the left of the grayscale is an 
image of a model 
wearing a black hat. 
Ensure that there is 
detail in the hat. 
Finally, check the 
lower right corner 
of the color chart. 
The color patch 
should be a deep 
“burgundy” red. 

- Often only very slight changes in gamma are needed to 
give an optimal result. When satisfied, close the control 
panel and save the profile.
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Setting up the software
For Photoshop 5.0 users 
– not recommended for Windows 2000

RGB
- Start Photoshop
- In the File menu, select Color Settings – RGB Setup.
- Select Adobe RGB (1998). Adobe RGB is a standard, 

and frequently used, color space.
- Select “Display Using Monitor Compensation”. 

All other settings are automatically taken from the 
monitor calibration. Click OK.

- The screen can now show accurate RGB values.

CMYK
- In the File menu, select Color Settings – CYMK setup.
- Select ICC as the option under CMYK Profiles.
- Select a profile that fits the type of color printer or printing 

process used. Printer profiles must be added to the profiles 
folder before they can be selected. 

For Windows 2000 place the desired profile in the “Color”
folder under WinNT/System32/Spool/Drivers. 

For Windows 98 place the desired profile in the “Color” 
folder under Windows/System

- Please note that if the screen is to show accurate CMYK 
values then the correct ICC options must be set at all times. 

Sometimes it is not possible to predict which printing process
the customer will use. Therefore a “safe” option can be to
choose “Offset print -Euro or US catalog” combined with
“Heidelberg CMM”

Color Management for Windows
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The screen can now preview accurate CMYK values. 
This is particularly useful when previewing an image that will be
reproduced in a magazine or catalog, - especially if the colors 
are difficult to print. This technique is called “Soft-Proofing”

Profile
- In the File menu, select Color Settings – Profile setup

- Check all the boxes in the Embed Profiles section. 
This allows other users of Photoshop to open the same image 
and view colors correctly. 

ICC profile aware software is the future of color management.
When an image has a profile embedded, the software can
accurately display and convert the color because the profile
instructs the color management system about the color profiles
of the devices that created or edited the image.

- Select the following for the Assumed Profiles: RGB - Adobe 
RGB (1998): CMYK - select a suitable profile 
(if known): Grayscale - Gamma 2.2.

Assumed profiles instruct Photoshop what to do when an
image does not have an embedded profile.

- Select the following for Profile Mismatch handling: 
RGB – Convert to RGB Color: CMYK – Ignore: 
Grayscale – ask when opening.

These settings instruct Photoshop what to do when the
assumed profile and embedded profile do not match.
A mismatch occurs when an image has no embedded profile.

3.5
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Three basic options are available:
- The mismatch can be ignored, in which case 

the image will be displayed without correction. 
- An image conversion can take place automatically, 

and a progress bar is displayed on screen.
- Finally a dialog box appears and the photographer is

asked to make a choice. 

The purpose of the Profile settings in Photoshop is to ensure that files
are reproduced accurately on screen when opened. Often the 
standard – default – settings are suitable. Photoshop recognizes files
with embedded profiles and can be set to automatically convert, 
or ignore, or to ask before opening these files.
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For Photoshop 6.0 users – 
recommended for Windows 2000

- Start Photoshop. Insert the LightPhase application CD.
- In the Edit menu select Color Settings.
- Click “Load”
- Navigate to the LightPhase application folder and open the 

Goodies folder.
- Open the Photoshop 6.0 settings folder and select the 

Photoshop 6.0 defaults. Click “Load”
- Photoshop 6.0 is now configured for use.

It is significantly easier to configure Photoshop 6.0.

Using the PhaseOne color checker with monitors 
- recommended for Windows 2000

- Open Photoshop and navigate to the LightPhase or 
Phase One Image Capture folder.

- Select and open the PhaseOne-CMS Checker Lowres.tif.
- Open the Monitor control panel.
- At the bottom of the PhaseOne-CMS Checker are a color 

chart and a grayscale. 
- Adjust the Brightness control so that all the steps in the gray 

scale are clearly visible. To the left of the grayscale is an 
image of a model 
wearing a black hat. 
Ensure that there is 
detail in the hat. Finally,
check the lower right 
corner of the color 
chart. The color patch 
should be a deep 
“burgundy” red.
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4 Printing

Destination profiles
A destination profile is the profile that describes which device is used
to reproduce the final image. In practice this could either be a printer
or a monitor. Monitor setup has already been described in this guide.

For the purpose of this discussion there are three basic groups of 
destination profiles for printers:

Profiles installed with the Phase One software. These are basic
CMYK printer profiles that cover the generic catalog printing 
standards in use around the world. 
As they are only generic profiles (and there are so many 
variations from printer to printer) the results from these 
profiles may not be perfect for every printing press.

Profiles supplied with a studio printer. These profiles enable 
correct color reproduction in the majority of cases, and can 
be installed and used by the photographer with little difficulty.

Customized profiles. To customize a printer profile 
(for either an RGB or CMYK printer) third-party software 
and hardware is necessary. The process to create a custom 
profile involves printing a standard target file that is supplied 
with the hardware calibrator (called a spectrophotometer). 
The color values of the resulting print are then read by the 
device and a custom ICC profile is generated.

Printing
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Proofing with the studio printer

Although it is not possible to describe the optimal procedure for all
types of studio printer, Phase One has a set of basic 
recommendations that can be followed. Some printers may require
specific setup procedures, which are clearly beyond the scope of this
guide. The guidelines below are intended to assist the photographer
in setting up the studio printer, but should not be considered a
replacement for any guidelines and procedures defined by printer
manufacturers.

- Many printers have a software or hardware user interface, 
which permits the user to adjust printer settings. Return to the 
default settings by disabling any color matching options and 
settings.

- Ensure that both the monitor and Photoshop have been 
set up correctly according to Phase One recommendations

- Start Photoshop and open “PhaseOne-CMS checker.tif”. 
This is a high-resolution version of the file used to adjust the 
monitor settings.

- Make a print.
- Compare the image on the monitor to the printed image. 

Ensure that viewing conditions are optimal. 

Please note that to compensate for adverse viewing 
conditions the monitor should be fitted with a hood. 
This prevents light falling on the surface of the monitor. 
Ideally the viewing environment should also be neutral 
gray, and the ambient lighting set at 5000 Kelvin. 
Also the print should be viewed, and compared to the 
monitor image, using a 5000 Kelvin light source.

- If the shadow details are less visible on the monitor, 
than on the print, adjust the gamma settings with the 
Adobe Gamma tool. 

4.2
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- If using Windows 2000 then please read “Using the 
PhaseOne color checker with monitors - 
recommended for Windows 2000” on page 3.7  

- Do not change the monitor calibration settings in 
Photoshop as this will adversely effect the relationship 
between the LightPhase, or Phase One Image Capture 
software, and Photoshop.

- Save a copy of the “PhaseOne-CMS checker.tif” as a 
CMYK file, in Photoshop. Open the file and compare it 
to the print. If there is a difference the shadow details 
between image on the monitor and the print adjust the 
gamma settings as needed.

Adjust the gamma settings until the best result is obtained. Do not
expect 100% accuracy, it is not technically possible given the gamut
limitations of monitor and printer. The goal is to know exactly how 
an image will be reproduced on a printer as compared to the 
monitor.

If there is significant variation in the color of the printed image, 
when compared to the monitor image, then please check the 
following points:

- Ensure that the monitor is setup according to 
Phase One recommendations.

- Ensure that the correct printer driver is installed 
according to the printer manufacturer’s 
recommendations.

- Ensure that Photoshop is setup according to 
Phase One recommendations.

If significant color variations persist then the printer may require 
servicing.

Printing
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